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Welcome to COLOR+, U-1e ultimate graphic art 
program for the Apple IIGS. Color+ is a complete 
Paint and Animation program. Unlike other paint 
programs, Color+ can handle 256 colors within one 
picture. With it, you can convert pictures from 
Super Hi-Resolution 32 0 mode to Super Hi­
Resolution 640 mode or visa versa. COLOR+ even 
allows you to mix 32 O mode with 640 mode within 
the same picture I Whether you plan to use your 
Apple I IGS for educational purposes, for design 
work, or just for fun, you will find Color+ perfect 
for creating both animation and graphics. 

EL KASSIR Software is committed to serving our 
customers, and we are open to your suggestions for 
updating and improving this product. Please 
address letters to: 

EL KASSIR Soft\\lare 
232 Thorne St. Suioo c 
Los Angeles, CA 90042 

For technical support, call us at (213) 257-6882 
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How To Use This Manual 

This manual is divided into chapters that guide you 
step by step tluough every feature of COLOR+. 
Because COLOR+ uses pull-down menus for most of 
its commands, it is relatively easy to use. Chapter 
is a quick tutorial and it wilt help you getting 
started. After you have completed and carried-out 
the functions in the manual, you should be able to 
use COLOR+ Without documentation. If you forget 
an operation or a specific function, the reference 
section in Chapter 3, has detailed explanations. 

Color+ is not copy protected for your convenience. 
You can easily install it on a hard drive. However 
you are allowed to make only ONE copy for backup 
purposes, either on your hard drive or floppy 
disks. Please help us serve you - better by not 
pirating this program. The generation of this 
piece of software took lots of effort and 
time to make it very convenient for you. If you 
know someone who could benefit from our 
program, please have them contact us or your local 
dealer. 
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System Requirement 

Color+ requires at least 766K of memory (RAM) 
and at least 1 disk drive, although 2 disk drives 
are recommended. While working with COLOR+ the 
program disk should always be pn~sent in the 
drive. An Imagewriter II is required for printing in 
color. 

Update Policy 

We intend to constantly improve COLOR+. As long 
as you have returned your Registration Card, you 
will be notified of any significant updates to the 
Color+ software. Your suggestions for features for 
future releases would be appreciated. We also 
welcome your comments about this software 
product in general. Please write to tell us what 
you think; Our address is printed on the front of 
this manual. 



CHAPTER 2 

Starting Out 

Before you boot Color+ put the Color+ demo disk in 
drive and boot it. If you are using the Finder~ 
double click on the DEMO.SYSTEM as shown below. 

/ Ii File Edit ' 

D DEMO D 

l!t 1. 

◊ □ □ 
DEMO 

DEMO .SYSTEM 

,.._ 

+ 
+-I I ➔ ~ 

'--

You will see a slide show of many pictures created 
with Color+. Notice that each picture has more than 
16 colors at once. Some have mixed graphics 
modes. This disk also contains a demo of the 
ColorMix program. Check it out! The demo disk 
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toes not contain the animation demo. We Will use 
he animation demo later on in this section. 

\fter you are done with the Color+ demo, remove 
he demo disk. Replace it with the Color+ program 
m reboot. You can also reboot by double clicking 
>n the COLOR.SYSTEM icon if you are using the 
•inder as shown below: 

II Filt Edit Vit-w Disk S ecial Color 
COLORPLUS 

~ □ □ COLOR .SYSTEM 

□ □ □ 

When the Program is executed, the initial 
resolution of the screen ts 320 mode. The IIGS 
screen has two screen resolutions:320 & 640 pixels 
on each line. The vertical resolution is always equal 
to 200 lines. As shown on the next page: 
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0 639 

640 Mode 

Using Color+ you can individually control the 
resolution of each line For example, the upper 100 
lines can have 32 0 pixels resolution, and the lower 
100 lines can have 640 pixels resolution. The 
actual line resolution is set using the control 
panel ·s SCAN command: 

Move the mouse the boxes next to the Scan 
command and set the follov'ving variables as follow: 
Y 1 .. o, Y2 • 100, p .. o, Mode"' 32 0. Now click on the 
SCAN command and the first 100 lines have 32 0 
mode as the screen resolution, they Will be using 
palette 0. Similarly you can set Y 1 = 1 0 1, Y2 = 199, 
P= 1, and Mode=640 then Click on the Scan 
command and the lower 100 lines have 640 mode 
as the screen resolution and they v'vill be using 
palette 1. 
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Now to tell Color+ which resolution to use you 
need to go to the 'Option· Menu and set the 
drawing resolution accordingly. 

The drawing mode and the actual screen resolution 
are two different things and are controtled 
separately: 

1- The drawing mode 320 or 640 mode can be 
controlled from the option menu ·set GrMode 
=320/640" as shown below: 

Set GrMode:640 

Setting the GrMode attows you to force one 
drawing mode or the other regardless of the actual 
screen resolution. With option you can control 
dithering (dithering is the ability to display 16 
colors on the 640 mode by placing different colors 
next to each other so they will give the appearance 
of a different color. For example a line of Red and 
Green dots adjacent to each other appear to have a 
yellow color) or non dithering effect on the 640 
mode resolution. When using 640 drawing mode, if 
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the actual screen resolution is 640, mode then only 
4 colors are effective for drawing. While if the 
drawing mode is 32 0 and the actual screen 
resolution is 640 then the dithering effect is on and 
you can have 16 different colors on the 640 mode 
screen. 

2- The actual screen resolution can be controlled 
using the control panel's SCAN command as show 
below: 

Scan Command on the Control Panel 

You may be wondering what happens When the 
actual resolution of the screen is 640 and the 
drawing mode is 320. Well try it. This is a valid 
command with it, you can choose between 4 pure 
colors on the 640 or 16 dithered colors. 
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Conversely the actual screen resolution can be set 
to 320 mode and you change the current drawing 
mode set to 640. However, even though it is a valid 
command, the lines won't look good. Color+ will try 
to use the 640 mode routines on a 32 0 mode 
screen. 

The Change to 320 or 640 mode affects the 
following commands: Fill Mode, Lines, points, 
circles, rectangles, the coordinate system, the zoom 
routines and the appearance of the control panel. 
Because the color of the control panel and its 
resolution are taken from the current palette. The 
current palette (A palette is like a Paint Box that 
have 16 colors) is the palette whose number is 
displayed next to the color selection as sho'v'lfl on 
the next page: 
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➔ 

Palette Number is displayed 
tn this box. 
The Colors on the right renect 
the colors for that palette. 

Sometimes the control panel colors or text might 
not be displayed clearly, this is because the colors 
and resolution used for the control panel uses the 
current colors and palettes. It should not be a 
cause of concern. You can fix it easily by changing 
the current drawing mode. 

When you first boot, the palette selected might not 
be the same one displayed. To display a particular 
palette use the ·up· and 'down· arrows of the 
palette selection box (Shown on the previous page). 
When you select a palette the 'RGB' and 'L' options 
on the control panel affect that palette. This way 
you can edit the color of any palette to any 4096 
possible colors. 
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The ·patrn · menu let you select a pattern to tilt 
any closed area. Choosing Solid Color lets you fill 
closed area With that color when you are using the 
fill tool from the tool menu. You can also fill areas 
with patterns. There are 12 predesigned patterns 
accessed from the 'ptrn' menu. You can change 
these patterns using the Pattern Editor program in 
the ·color· Menu. 

To mix colors, and design palettes there ts a 
program called ColorMix. The ColorMix routine can 
be accessed from the 'Color· Menu, lets you mix 
colors using their original Red, Green, and Blue. It 
lets you see the composition of any color. The 
ColorMix program makes it instructional and Fun to 
experiment with mixing colors. You will have an 
idea what the original components of each color 
are. For example, When you select a maximum Red 
and a Maximum Green on the resulting color is 
Yellow. The picture below shows the screen of the 
ColorMix routine. 
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ColorMix Program and Functions 

How it is ROSSible to have 256 COLOR? 

On the Apple IIGS, each of the 3 color components, 
red, green, and blue (RGB) can have up to 16 levels 
of intensity. A color is made of the combination of 
the 3 components. Since we have 16 levels of red, 
16 levels of green and 16 levels of blue there are 
16 x 16 x 16 or 4096 different color combination. 
The Apple IIGS has the capability to display 256 
colors at once out of the 4096 colors. Color+ allom 
you to access the full color capability of the I IGS. 

17 



Hl 
[ ' T 9 

T ; 
E g 

s ~o 
11 
12 
13 
14 
HI 

COLOR NUMBER 
f Iii' 

0 12345 6 7 8 9101112131415 

--/ 

-✓ l7' 

----
' 

'/ ~ 
,r ~: ~ 

_,,.. 
/ I I I 

y R G B --
1 6 Palettes, each palette 16 colors. 
Esch Color composed of Red, Green 
and Blue. Each Bas1c color con have 
16 level of 1 ntenstty controloble 
from the control panel RGB and L. 

I 

I 
I 
I 

As show in the pictures above, Colors are stored in 
palettes. A palette is a set of 16 colors. Each 
picture can have up to 16 palettes, this what 
makes the 2 56 color limit. 

You might think of a palette as a paint set of 16 
colors. Each color can be set tndepEmdently. The 
Apple I IGS can handle up 16 independent palettes. 
It is as if you have- a paint box that has 16 
different palettes, place to store colors, and each 

. storage area can have 16 colors. Thus, you can 
paint with 16 colors x 16 palettes or 2 56 colors at 
once. One restriction is that each line can have one 
palette assigned to it, can contain only 16 colors. 
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But different lines can be assigned different 
palettes so you can paint with 256 colors on the 
whole screen. 

Now we will introduce you to the concept of SCB 
(Scan Control Byte): 

Scan Bytes X- Coordinate (0-319) or (0-639) 
1 for each line. I [) 

y 0 
~-----+---jf---+-----+-•/ 

C I 
0 2 ._-+--+---+--+,,...,--,,V-
0 3 -------,---/ r 4 

tech Pixel Conte1n e number from 
d 5 i ( 0- 15) on 320 mode end 
n ( 0-3) on 640 mode. 
e Every Seen byte correspond to 1 line. Each -~t----~ Seen Byte contain t'w'o important information 
e ebout that 1i ne: 

0 

1 
9 
9 

1- I ndlcate the Line Resolution 320 or 640 
2- Contain a number from Oto 15 

indicating the paJe·tte number. Any time 
anything fa dra'w'n on that line, the colors 
of that line are taken from the palette 
number Indicated 1n the SCB (Scan Byte). 
Use the scan commend to control the SCB. 

There are 200 vertical lines on the IIGS, Using 
Color+ you will have the ability assign each line a 
different pal et~ (Each line can have a separate 
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palette up to 16 palettes). Because each line has 
one Scan Control Byte. This byte tells the computer 
both which palette out of the 16 to use and the 
resolution of that line. 

Coloh has made it easy for you to play with all the 
different combinations. Using the graphics control 
panel on the bottom of the screen, you can change 
the palette and the resolution of any line or set of 
lines. 

To change the palette and the mode of any set of 
lines, just go to the graphics panel on the bottom of 
the screen. Set y 1 and y2 then set the palette and 
the mode, then press on the ·scan· button. The lines 
between y 1 and y2 now have the palette you set 
and the mode you set. 

For fine tuning your drawings, the Zoom program 
lets you display any portion of the screen in 3 
different zoom levels. The zoom routine can be 32 O 
mode zoom or 640 mode zoom, depending on the 
·set GrMode' command in the option menu. 

As stated earlier there are 12 different fill 
patterns. To edit a pattern go to the Color menu 
and select pattern editor. Then the current pattern 
is displayed. 
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There are some pictures on the disk.: SUNS, MAIN, 
or INCIDER. Try to open them from the file menu. 
Using Color+ you can open $C 1 type and Binary 
type pictures. These are the standard Super Hi-Res 
pictures. You cannot load compressed pictures with 
type $CO using this version. 

Running the Color+ Program. 

Boot the color+ program disk, you can boot either 
from the Finder® or from the disk. If you boot 
from tl1e Finder just double click on COLOR.SYSTEM 
after a while the program will be ready. 

Check out some of the 2 56 color pictures on the 
disk. The graphics control panel will f adlitate 
manipulating complex drawing multipalette (2 56 
Colors) pictures. In fact, using this interface alone 
you can create variety of special effects. 

Animation: 

You can Record your moves I Using Color+, you can 
record your drawing commands by activating the 
record option. You can turn on/off recording from 
the animation menu. Using this option, you can 
create many animation effects. To get an idea of 
the things that can be done, we·ve designed some 
animation file for you to look at. 
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Loading and running an animation tile: 

Go to the animation menu and select 'Loa<i 
Animation·. The load animation window will show. 
Double click on the animation folder. In this folder 
there are many predeslgned animation files. Load 
the file called DEMO2 .ANM by either double 
clicking on the file name or by highlighting the file 
name and clicking on the open button. 

You will now have the option of playing the file. 
Before playing back this tile, do the toll owing: 

- Go to the 'Patrn· menu and select a solid color 
for the Fill command. This will init the fill 
command · to be a solid color instead of a 
pattern. 

- Go to the tool selection and select the fill 
command. Now Fill any area. 

- Then go to palette selection arrows next to the 
colors and select palette 0. This will init the 
displayed palette to 0. 

- Finally go to the animation menu and select 
play back' option. 

The animation file will be played back. This 
animation file is similar to short cartoon. You can 
create various animation and color cycling effects. 
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Things to watch for when working With 
animation: 

The animation file will not reset the screen to its 
original value when you start the animation. You 
must reset it before you start animation. Resetting 
is what we did in the previous paragraph. 

Now: If the previous picture on the screen before 
you run your animation was multi-palette picture 
You must reset the screen to the original working 
palette. 

If the above animation file shows irregular colors, 
let it play though, then play it again. The Colors 
should be normal. 

Now play the CYCLE.ANM, INTR02.ANM and other 
files. Just load the me and play it. You may find it 
necessary to clear the screen to color O, before you 
play back the file. 

Try to create simple animation files on your own. 
To start a new animation file two simple steps are 
required: 

1- go to the animation menu and turn on 
recording. 

2- go to the option menu and select ·start New 
Animation· 
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Now your moves will be recorded as you use 
Color+. Around 20 different commands can be 
recorded. To play back your moves only 1 step is 
required: 

Go to the animation menu and select 'Play Back'. 

To save your animation file go to the animation 
menu and select ·save Anim' 

Using Color+ animation you can create very 
inwresting scenes and presentations and short 
cartoons. 

You can make short lessons in mathematics in 
learning about colors. Color+ animation can be used 
for a variety of educational purposes. 
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CHAPTER 3 
Reference Section 

General Overview. 

This chapter and the next one explain all the 
options available to you for use with Color+. 

The Color+ main menu looks like this: 

s file Edit Select Colors Option Tools Pstrn Anlmst 

We will go through each menu items and explain 
its function. 

Using the fJlf! Menu: 

The File menu looks like this: 
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Lood Picture 
Sova Picture 
Lood Palette 
Sove Palette 
Quit To BASIC 
Quit 
Sho e Editor 

Loading Pictures: When you select this option, a 
window opens to load the picture. The name of 
your boot volume appears at the top of the 
window. You have many different options to select 
from. You can use the arrow to display all the files 
on this directory. Pictures are displayed in colors 
different from directories. To open a picture or a 
directory, either double click on the file name or 
highlight it and click on Open. 

The Disk access window looks like this: 
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Select Picture To Load 

I Current Pathname 

Picture Names are 
displayed in different 
Colors then 
Directory Names. 

Disk 

Open 

Close 

Cancel 

when you open a directory me, the current 
pathname is displayed in the upper window. 
Using the close command closes the last 
subdirectory. Clicking on the pathname will also 
close the last directory. If the current pathname is 
the main (root) directory, nothing happens, when 
you click on th pathname. 

When you are in this window, the program won't 
detect the insertion of a new disk. The program 
can, however, detect when a disk has been 
removed. It will no longer display a removed disk. 
If you want to change disks you need to click on 
·cancel' to go back to the main program, then 
change the disk. 
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Saying Picture: The process for saving pictures is 
similar to loading them. The disk save window 
looks like this: 

Select Picture To S6'18 

I Current Pothnome 

Picture N6mes ore 
displayed in different 
Colors then 
Directory N6mes. 

I Disk 

I Open 

I Close 

I Concel 

._ _______ - I Sova 

This is the text window 

Pictures are saved on the subdirectory displayed 
on the upper window. To enter the file name you 
need to click on lower text window with the mouse. 
Then use the keyboard to enter the text. 3 
commands keys can be used with the edit text: 

1- 'Delete· lets you delete the last 
character typed. 



2- '<--' backspace also. let you delete 
the last character typed. 

3- 'Return· lets you go back to mouse 
control. 

When entering text, the mouse is disabled. 

Pressing the 'Return· key will let you control your 
mouse again. 

Note: The pictures displayed in the file access 
window displays only standard super hi-res 
pictures of type $C 1 or BIN. 

Loading Palettes: Loading palettes is the same as 
loading pictures except that only filenames that 
end with '.PAL' are displayed only. If a palette is 
saved using the "save palette" option, the program 
automatically adds the '.PAL' suffix to the filename. 
If you've designed a palette using Supergraphix I I 
program, to access it from Color+ you need to make 
sure the file name is in this format: xxxx.PAL. 

After the palette is loaded from disk, it ts stored in 
the palette buffer area. At this point you can use 
the 'UNDO Old Palette· in the ·option· menu to 
toggle between the current palettes and the just 
loaded palettes. 
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Saving Palettes: the user interface for saving 
palettes is the same as saving pictures. The save 
command saves all 16 palettes under the filename 
you entered. 

Quit To BASIC; Sometimes you will find it 
necessary to quit to basic to do some miscellaneous 
work such as seeing the catalog. If you are in 
BASIC, type one of the follo'Wing commands to go 
back to COLOR+: 

• RUN TOMRIN.INIT This command takes you back 
to color+ leaving all your screens intact. What 
ever picture was displayed before, will now be 
displayed again. 

• RUN INIT.2 This command takes back to 
COLOR+ and it clears the screen. Your previous 
work 'Will be erased, because you will be 
starting new picture. 

Quit: The Quit command lets you return to the 
launching program. If you booted from the Finder 
you go back to the finder. Before the program 
quits, it will ask if you are sure you want to quit. If 
you are unsure if you have saved your work, stop 
the Quit and save your picture. Once you quit any 
unsaved picture will be lost. 
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ShaJ!e Editor: This option will takes you from 
Color+ program to the Shape Editor. The shape 
editor program allows you to draw, design and link 
shapes for use with color+ as brush or as shapes for 
your animations. Chapter 4 is devoted to describing 
the features of the shape editor. 

Note that when run the shape editor, your previous 
work remains intact. When you quit from the 
Shape Editor, all your pictures and animation files 
are still there. The only thing you loose is old paste 
shape. The old shape is replaced with Whatever 
shape you·ve created in the shape editor. Even 
though you will not lose your work, it is still 
advisable to save your work before shifting into 
the shape editor. 

Warning: If you did not use, or toad any shape 
when you executed the shape editor program, 
don·t use the paste command directly when you·re 
back into Color+. First use the . copy command. 
Failure to use the copy command before the paste 
command in this case, wilt hang the program, 
causing it to lock. 
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Using The Hdit Menu 

The Edit menu looks like this: 

Cl ear Screen 
Undo 
Invert 
Co 
Pnste 
2-Rotote 90 
Current Mode=O 

Clearing the Screen: This command clears the 
screen to the current color. Before carrying out this 
command, the program ask you only once if you 
are sure. Once the screen is cleared, your picture 
will be lost. The UNDO command will NOT restore a 
picture once it has been cleared. 

UNDO: This command is very helpful. If you make 
a mistake, you can use the undo command to 
repair it. However you still need to take special 
care. The Undo command will undo only the last 
move. That means if you've made a mistake and, 
then draw an extra line or fill with the wrong 
pattern, you can go and undo the last move, but if 
you click anyWbere on the screen beside the menu 

32 



bar your last move ts saved and you cannot undo 
it. 

The last move is considered any action you make. 
Any time you click on the mouse you have 
completed an action. The UNDO command will only 
undo the last action taken. 
Although we have built-in many safeguards, it is 
still a good practice to save your work regularly. 

Invert: The command will invert a particular area 
of the screen. The area inverted is the last area 
accessed with the Copy command. 

Cop._L This command is the same as the copy toot 
in the tool Window. You can copy any area of the 
screen and paste it anywhere you 'Want using 4 
different drawing modes explained in the following 
paragraphs. To Copy an area of the screen click and 
drag, then release the mouse button. 

When using Copy, the area you select Wilt depend 
on the ·copy function· currently selected: 

1- Copied as is 
2- Rotated 90 degree 
3-Rotated 180 degree 
4- Rotated -90 degree 
5- Mirror imaged. 
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All the above functions will perform differently in 
320 and 640 mode. The 'Set GR MODE' in the 
·option· menu determines the current drawing 
mode regardless of screen mode. 

Paste; The last shape copied can be pasted 
anywhere on the screen. When you choose this 
option the current cursor show the shape to be 
pasted. You can move it anywhere using the 
mouse, whenever you click the shape will be 
drawn at that location. The mode the shape is 
drawn depend on the mode selected 0, 1,2, or 3. 

Set Copy FuncUon: As mentioned before, there 
are S different ways you can copy an area on the 
screen: 

1-Make Shapes 
2- Rotate 90 
3- Rotate 180 
4- Rotate -90 
5- Mirror image 

The option shown when you pull down the 'Edit' 
menu is the function selected. any time you select 
this option the next option mode will be effective. 
And the next time you pull down . the 'Edit' menu 
that option will show. If the The 'Make Shapes· is 
shown then when copying the copy copy will use 
the 'Make Shape· option. 
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Set Paste Mode: There are 4 dtff erent way you 
can paste a shape: 

1- Mode=0: this mode will paste the shape as is. 
The background behind the shape is 
completely replaced by the shape picture 
elements. 

2- Mode= l: this mode Will make ·color 0 of the 
shape transparent to the background. That 
means when you paste a shape in this mode, 
any color o in the shape will show the 
background. 

3- Mode•2: this mode will XOR the shape pixel 
elements with the background pixel 
elements. For example a white in the shape 
pasted on a white on the background, wi11 
turn into a black. The truth table for this 
function is as follow: 

Shape BackGD 

0 
0 
1 
1 

0 
1 
0 
1 

Result 

0 
1 
1 
0 

Color are numbered from 0 to 15 
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Color Num Binary Value 
Color O 0000 
Color 1 0001 
Color 2 0010 
Color 3 0011 
Color 4 O 100 
Color 5 O 101 
Color 6 O 110 
Color 7 O 111 
Color 8 1000 
Color g 1001 
Color 1 0 1 0 1 0 
Color 11 1 0 11 
Color 12 1100 
Color 13 1101 
Color 14 1110 
Color 15 1111 

Selecting Pen Size 

The Select menu looks like this: 

Size=l 
Size=2 
Size=3 
5120=4 
Slze=S 
Slze=6 



This menu item lets you select the drawing size for 
all lines (points, lines, circles rectangle . ..) When 
you print text the size or the text and shapes 
drawn will depend on the Size selected. 

This command is affected by the 'GR Mode' 
command in the ·option· menu. The size of the 
drawing unit depends on the Gr Mode value either 
320 or 640. Here are the following pixel size for 
each drawing mode. 

In 320 mode (when GrMode=320): Size= 

1 2 3 4 5 6 

In 640 mode (When GrMode■64): Size ■ 

1 2 3 4 5 

a HIB 

■■-
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Colors Menu 

The Color menu looks like this: 

••1nm1."111 
This Color 
This Polette 
All Polettes 
Edit Pot tern ... 
Mix Colors ... 
This Pol --> All 
This Col --> All 

This Colo[;_ This option is necessary when you are 
using the RGB and L option on the control panel. 
When this option is selected, the RGB and L 'Will act 
only on the color selected and shown. Try to Clear 
the screen to Color "1, then click on color• 1, then 
use the R,G, and B option to change Red, Green and 
Blue component of Color• 1. 

If after changing the RGB value of a particular 
color, the color doesn't change, use the 1"his Color· 
option to make RGB and L active again. 

This Palette: Selecting This Palette· makes the 
RGB and L on the control panel active on all the 
colors in the current displayed palette. This· option 
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allows you to easily create a palet~ with a uniform 
intensity of one or more colors. That is, you can 
make a palette with a set amount of red, blue, or 
green or with a certain light or darkness 

All_ Palettes: This option has the same effect as 
the 'This Palette' Option except it acts on all 
palettes. 

With this option you can change the RGB and L 
component of the whole picture. 

Bdlt Pattern: Using this option invokes the edit 
pattern routine. You can change and edit Fill 
patterns. After you·ve created a new pattern this 
pattern will be effective on you( drawing when 
you quit back to Color+. 

When designing a pattern for use with 640 mode, 
be sure to draw your pattern using only the first 4 
colors. Any pattern can be drawn on both mode. 

For additional information about patterns look at 
the ·patterns· section in this chapter, and in 
chapoor4. 

Mix Colors: This option allow the user to change 
and mix color. The color mix program allows the 
user to see visually how colors are composed. It is 
a fun and educational tool. At the same time, it 
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allows you to choose your colors more effectively. 
For example if you are designing a Sunset scene, 
you can plan your colors ahead by mixing the 
original colors together. A more detailed 
explanation of the ColorMix program is present in 
chapter 4. 

This Pal --> All: This option gives you more 
flexibility in designing pictures. For example if you 
want to start with the original palette. you can set 
all the 16 palette to the current displayed palette. 

Your old palettes are not lost. They are stored in a 
buffer area in memory. If for any reason you want 
to restore your old palette back you can use the 
'UNDO Old Palettes· in the Option menu. 

This Col --> All: This option is useful when you 
want to start with a color and change it as palettes 
change. This option let you change the value or this 
color in all the palettes to the current color. 

For example if you have a yellow color in color •2, 
and you used this option, all color•2 in all palettes 
wilt change to yellow. 
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The Option Menu. 

The Option menu looks like this: 

Set GrMode:640 
Show Coordtnotes 
Hide Control Ponel 
Undo Old Polettes 
Start New Anim. 
Buff er Picture 

Set Graphics mode: This option let you toggle the 
current drawing mode from 320 to 640 mode or 
vise versa. 

Now that this option won't change the actual 
screen resolution from 320 to 640 or vise versa. 
Rather, this option informs the program that it 
should use the 640 or 320 drawing routines the 
next time an operation is performed. To change the 
actual screen resolution you need to use control 
panel. 

For example, supposed your picture consist of 
screen from o to 100 a resolution 32 O mode 
resolution, and from line 1 O 1 to 199 a resolution of 
640 mode and suppose the current GR MODE is set 
to 320. When you plot a tine, the line will use the 
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320 mode routines regardless of where you draw 
on the screen. If the GR MODE•640, then the line 
drawn will use the 640 mode routines. 

Sbow Coo_ul&nates� This option lets you see the 
coordinates. These coordinates are displayed only 
if the control panel is shown. They are displayed 
on the lower right of the control panel. The 
coordinates go from 0 to 319 in 320 mode and 
from o to 639 in 640 mode. Y coordinates go from 
o to 199 on both modes.

Hide Control Panel: This option hides or shows 
the control panel. When hiding the control panel, 
the picture will be displayed starting from the top. 

Note: When you use this option make sure the 
picture is not scrolled. 

U:HDO Old Palettes: This option is useful for 
restoring old palettes in case of error. Also, when 
loading a palette from disk, the loaded palette is 
stored in the buffer areas. To transfer those 
palettes to the main screen area use this option. 
You can use this option to toggle between old and 
new palettes. 

Start New Alllm_._ This option allows you to start a 
new animation file. To execuoo this option, the 
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Record option should be turned on. Otherwise this 
selection has no effect. 
Be careful. If Record was on and you select this 
option your previous animation f il� will be lost. If 
necessary save your file before using this option. 
This option resets the animation pointer to the 
start of the animation file. 

Buffer Picture This option allo"W'S you to work 
with 2 different pictures at the same time. You can 
use one picture as a buffer picture to store 
miscetlaneous clip art or any other drawings for 
use with the other picture. Or, if you designed 
critical drawings, you can use the buffer to save 
your picture, so you don't lose your work. 

Tools: 

The Tool Menu looks like this: 

Tools 

t ,. [] +
I * B (3 

0 @ A 
-� 

it 

□ ri\J a

···•■
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At any time 'When you click on the toot menu, the 
tool you are currently using will be highlighted. 

The following explain each of the available function 
in the Tool Menu: 

~ 2. 
I 

3··1 
l. .. 4+-

5/ ~~ ~ ~ I 

D tID 1 1 1 21 
n R1.l 

~ ·~ 15 
V 

1- Plot 
2- FiJI 
3- Copy ···•■ 

9- Plot Circle 
10- Plot Circles 
11- Enter Text 
12- Plot with Hr 
13- Plot recton~ 
14- Mony Rectrm 
15- Use Hnnd 

4- Get Color 
5- Plot line 
6- Plot lines 
7- Erose 
8- Plot with Shope 

z 
z 

oom Level 4 
oom Level 3 

Zoom Level 2 

1- Plot: This toot altom you to plot on the 
screen with the current color. This toot is 
affected by the size and by GR MODE setting. 

2- This is the Fill tool. Depending on the pattern 
selected using the Pattern menu, the fitl 
pattern can fitl a solid color or a pattern. 
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110 
gles 

3-

4-

The Fill command is affected by the GR 
MODE command. The appropriate fill routine 
is invoked depending on GR MODE. 

Copy. This is equivalent to the copy option in 
the Edit Menu. When you choose this option 
the rectangle you plot will be transformed to 
a shape depending on the ·set Copy Function· 
in the Edit Menu. 

The shape copied can be accessed in 2 ways. 
The first one is by using the paste command. 
(See ·set Paste Mode'). The other way a 
copied shape can be accessed is through the 
Tool •7 in the Tool Menu, the animation tool. 
Select tool •7 and Set the ST (Shape Table •) 
on the control panel to ·2 ·. Now the shape 
copied can used as a brush (You can paint 
with this shape). The current drawing mode 
is set using the 'M' option on the control 
panel. 

Get Color. This tool flashes the color selected. 
If the color selected is on different palette 
then the one displayed, you will not be able 
to see the color. In this case, select "different 
palette" and click on that color again. Repeat 
until you find the color value. 
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Another way to get the color, is to select 
'Show Coordinates' in the ·option· Menu and 
get the coordinate of what line the color is 
on. Now use ·y 1 · or 'Y2 · on the control panel 
and move to the line where the color is 
drawn. The palette number of that line will 
be displayed in the palette window. Now you 
can go and show that palette, click on your 
color to find out what number is it. 

5- Line tool. This tool allov-,s you to plot lines. 
Like the plot tool, this function is aftected by 
the current size setting, and by GR MODE 
setting. 

On a multlpalette picture, same color 
number on different palettes might have 
different values, so as you plot lines or 
points, these lines could have many colors. 

6- Same as tool •5. except that the first click 
determines the center of many lines so long 
as you move the mouse and keep the bottom 
pressed. 

7- This is an eraser tool. This tool erases in 
Color- I 5. To erase in different colors, you 
can use a large size with the plot tool, and 
select the desired color. The plot tool will 
then act as an eraser also. 
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8- The animation tool. This tools allows you to 
import shapes developed using the Shape 
Editor Program and use them with your 
pictures. 
The 'SH.... option on the control panel 
determines the shape number to be plotted. 
The 'M' option determines the current 
plotting mode. The 'ST' option determines 
the current shape table selected. As you 
cycle between shapes using the 'SH'' option, 
the current shape will be briefly displayed 
in the upper left corner of the screen. 

Shape Table • 1: is the one that you load 
using the animation menu 'Load Shape·. This 
shape can be any shape or series of shapes. 

Shape Table '2: is the one that you make 
using the copy option. 

Shape Table "3: is Font table " 1 

Shape Table • 4: is Font Table "2 

Shape Table '5: is Font Table" 3 

Shape Table 116: is Font Table• 4 
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Play around with this option and experiment 
with it. You can Draw pre-designed shapes 
and patterns, and use them as the unit 
drawing. The shapes drawn are affected by 
the mode setting on the control panel 'M' 

9- Circle Tool. This tool allows you to plot circle. 
The current drawing mode is determined by 
the GR MODE command in the 'Option· Menu. 

10- Multi-Circle drawing. The first click 
determine the center of the successive circle 
plotting. 

11- This the TEXT entry tool. There are 4 pre­
designed fonts to use with this tool. The 
fonts to be used is determined from the 
control panel on the 'FT option. You can 
scroll between the 4 different fonts. 

FonVtt 1 (FT= 1): is the standard font for use 
with 320 mode. 

Font•2 (FT=-2): is the standard font for use 
with 640 mode. 

Font• 3 (FT=-3): this is a multi-colored large 
font. Only upper case are vaUd keys. 
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Font•4 (FT=4): this is a large font. It includes 
the entire alphabet set. 

Note: All Fonts can be edited. Also you can 
add or delete characters. This is done using 
the Shape Editor program accessed from the 
File menu. 

12- The brush Tool. This is an additional brush 
tool. The Animation Tool (Toot• 6) is a more 
useful and complete brush tool. 

13- The rectangle tool. With this tool you can 
draw rectangle. To draw a filled rectangle, 
draw it first then use the fill command. 

14- Multi-rectangle tool. You can create variety 
of patterns and effect with this tool. 

15- The hand tool. This tool is currently disabled. 
Use the right most option on the control 
panel to scroll up and down the whole 
picture. 

Zoom Levels: 
The Zoom level determines the enlargement level 
of the Zoom option. When choosing a zoom level of 
2, 3 or 4 the zoom routine is automatically invoked 
after you release the mouse button. 
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Thie Zoom routine will show you a rectangle Which 
depends on the zoom level selected. You can select 
What area to zoom on by moving that rectangle to 
the desired area and clicking once on the mouse 
button. 

More information about the Zoom Routine is 
available in chap~r 4. 

The Pattern Menu. 

The Pattern menu looks like this: 
Patrn 

The upper right corner displays the current 
pattern or color the fill command will use. The 
upper right corner, if selected, the Fill will be a 
solid color. This solid color is the current selected 
color on the control panel. When you click on the 
'Patrn· Menu the current pattern will be displayed 
in the upper left corner. Any pattern can be edited 
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to any 8x8 pattern using the 'Edit Pattern· option in 
the 'Color' Menu. 

The Animation Menu: 

The Animation looks like this: 

Lood Shopes 
Sove Shopes 
Record Is Off 
P1o Bock ... 
Sove Anim. 
Lood Anim. 

Saving Shapes: This option saves the area copied 
using the copy tool as a shape: When use use the 
copy tool, the 

You can load this shape either using the Open 
shape command or using the shape editor program 
accessed from the File menu. 

Using the shape editor program you can toad the 
shape and add it to another shape to form a larger 
shape table. Using the Color plus Animation menu, 
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you can load the shape and plot it anywhere on the 
screen with different drawing modes. This option 
allows you to design custom brush for use when 
painting. 

The shape saved is the one you see when you use 
the paste command. 

Loading shapes: This option wi11 load any shape 
table into memory. You can access a shape table 
from the animation tool, Tool 6 6 in the 'Tool' Menu. 
You can draw these shapes using drawing modes 
determined using the 'M' option on the control 
panel. Look into the M option on the control panel 
later on this chapter. 

The following is an explanation of each of the 
above function: 

This function allows you to load a shape table. To 
activate the shape table loaded, two steps are 
required: 

1- Choose the animation tool 
from the Tool menu. 

2- Make sure that the pointer (the 
'ST' variable on the control 

· panel) is set to 1. 

Re<:ord Is On/OU: When Record Is On there are 
around 20 different function that can be recorded 
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to create unlimited special effects and animation. 
These tunctions are outlined below: 

1- The pen and line toots 
When you use the pen and line tool, the 
program save your moves with the plot 
command. 

2- The pattern Pitt tool 
When you use the Fitt pattern option the 
program saves your moves using the pattern 
Fi11 toot. 

3- The color Fitt tool 
Similarly when you fill using a specific 
color, the above command is used to save 
your moves. 

4- The rectangle tool 
This is the rectangle tool in the tool menu. 

5- The Circle Tool 
This is the circle toot in the tool menu. 

6- The Color selections 
Any time you click on the color on the 
lower right of the control panel, The color is 
saved and used with the play back option. 
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7- The Drawing mode selection 
Any time you use the "M" option on the 
control panel, the current plotting mode is 
selected. 

There are 7 different plotting mode: 

MaO Plot the shape as is. This is the block 
mode: All the shape ·s pixels replace 
the background pixels. 

M= 1 Plot the shape with color O in the 
shape transparent to the background. 

M-2 XOR the shape pixels with the 
background. This is the Inverse mode. 

M•3 Draw the shape in the current selected 
color. Color O is transparent to the 
background. 

M=4 This mode is essential in creating 
animation. Make sure before you use 
this mode to use mode-6. When this 
mode is selected, any time you draw 
the current shape, the background is 
saved into a butter area, and is 
automatically restored when the same 
shape is drawn at another location. 
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If you forget to use mode=6 before 
this mode, the replay program might 
detect the error and open the shape 
for you. The Play Back routine can 
remember whether or not a shape has 
been opened. 

M=5 This mode restores the background of 
the current shape. By doing so, closes 
the shape. 

M=6 This Command opens the current 
shape. What is meant by 'open' is it 
saves the background '\1-lit.hout 
restoring old background. This is used . 
when displaying the shape for the 
first time. 

8- Custom Brush and shape tool 
This command dram shape number Sin the 
current mode. Make sure to specify a shape 
table '\1-lith ST command. 

9- The Clear command 
Using this command clears the screen 
command to the last color used. 

10- The shape pointer command 
When you use the ST option on the control 
panel, the program saves a pointer to the 
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shape table in use. The pointer uses this 
command to locate to a specific shape table. 

11- The Font pointer command 
This command is similar to the shape 
pointer, but it is used to point to a font table 
using the 'FT' command on the control panel. 

12- The Size command. 
Any time you use the size command from 
the size tool, this command is recorded. Be 
careful when using this command when 
record is on. You might have unpredictable 
results. 

13- Setting the graphics mode 320 or 640 

14- Cycling left and right commands 
Any time you use cycling color on the 
control panel, your cycling effects are saved. 
By using these commands, you can create a 
multitude of special effects. 

15 The text Printing command. 
Any time you use the Text tool from the tool 
menu. AU your text can be recorded using 5 
different fonts. Using this option you can 
create animated stories with animated text 
and picture. 
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16 The Scan command 
The scan option on the control panel allows 
you when recording is on to save these 
moves. 

17 The Palette command and RGB colors 
The R, G, B, and L commands are recorded 
and can create la very neat effect] when 
played back. 

Any function not mentioned here is not 
recorded when recording option is on. You 
need to be careful when using recording. 
Suppose recording 'W"clS off and you plot a 
circle, then you turn on recording then you 
use the fill command to fill inside the circle. 
When you play back your animation file the 
f ttl command will HU something other than 
the circle because the circle -was not 
recorded. 

Do not use ST=2 while recording. 
The record command will not record copy 
and paste. To avoid unpredictable effects 
that ST=2 will call, use ST=l, ST=3, ST==4, 
ST=5, and ST=6. 

The combination of all these function allows you to 
have hours of fun creating animation, educational 
lessons, presentation, short stories and so on, all 
this from within color+. 
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The following pictures clarify the use of shapes and 
modes when using the animation tool from the toot 
menu. The animation tool, together with function 
"l, "2, and "3 on the control panel allo\'-lS you to 
create various animation effects. 

Save Background 

Buffer oreo 
--- Shope toble 

I Shope" 1 

Step 2 

Draw The Shope 

M-6, SH•• 1, Drawing using the animation tool. 
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4-
M= 1-, SH•= 1, drawing using tht animation toot. 

Restore Old BckQd without dra\t'inQ the shape 
( Close the shape) 

M=5, SH'• 1, Drawing using the animation 
toot. 
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Creatjp_g Flickerless animation; 

M=O is a useful mode for creating flickerless 
animation. To create a walking man, the way to do 
it ls to design 4 scenes, for example, and while you 
are in record mode, draw one scene above the 
other by shift it from the previous shape. The 
result is a walking man, or a moving bicycle and so 
on. 

The DEM02.ANM file uses an example of tlickerless 
animation using the bicycle. 

Play Back: This option allom you to play back 
your moves. 

The length of the play file is limited to 2 2K. Any 
file larger than that wilt give an error. The length 
of the animation tile ls displayed on the 
lower right corner of the control panel any 
time you Turn On or Off recording. Although 
the program won ·t hang if you exceed 2 2K, 
saving the routine will cause a crash. You 
can do a custom-made save routine to save 
animation files larger than 22K in size. 

Save Anim. and Load Anim 
These two option allow you to save and load your 
animation work. They work the same way as 
loading and saving picture. The animation file is 
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automatically suffixed by '.ANM' When loading 
animation files, only '.ANM' files are displayed. 
When you save an animation file, another file is 
saved on the disk: The file suffix is ·.ANM 1 ·. This 
file is the current shape table pointed to by ST= 1. 
The reason that the shape table is saved when you 
play back your animation file is so you don't have 
to remember what shape table was used when you 
recorded your file. 

When loading an animation file, the shape table is 
automatically loaded. 

Quick tutorial: 

To get an idea how is the animation work, we 
created a sample animation file. to access it do the 
following: 

• Boot Color+ 
• Go to the 'Anim' menu and choose 'Load Anim' 

option. 
• The open file window will show. 
• Double click on the Animation Folder to open 

the animation folder. There you will see a file 
called INTRO.ANM 

• Double click on that file, and the INTR02 .ANM 
will load. Other Files you might check : 
DEM02 .ANM and CYCLE.ANM. 

• Go choose Color O 
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• Clear the screen. Then go to the Playback option 
to see this animation file. 

Tour animation folder may contain more 
than one animation file. Load them and play 
them back. 

Try to do some small animation file by yourself 
and experiment with them. 

Note that when drawing shapes, and using 
mode 4.,5, or 6, the first tlme you draw the 
shape you need to set M=6. Using the 
animation tool draw the shape at its initial 
location. Then change the mode to 4 by 
setting M-4. This way 1 the successive 
drawings will be proper. When you play 
back. the animation file., you will get the 
right effect. 

When you use mode 6 to record, click one fast 
click, then change the mode to 4. If you use a slow 
click, the same move may be recorded twice on 
play-back you will see a copy of your shape where 
it is not supposed to be. 

Since, when recording is on, you can only delete 
the last event recorded, be careful when creating 
large animation files, and save your work 
regularly. 
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Sample Animation: 
1- Go to the animation menu and Turn On 

Recording. 
2- Go to the Option menu and select Start New 

Anlm. 

Start by setting ST• 1 on the control panel, then go 
to Clear Screen on the Edit menu and Clear the 
screen to black. 
Now to create simple shape animation, set the 
mode M command on the control panel to 4, this 
mode let you draw without erasing the 
background. Then go to the tool menu and select 
the animation tool (the pacman shape) during that 
time all your moves are being recorded. Now you 
can click on the mouse and keep the mouse button 
do'W11 while moving the mouse, keep on moving the 
mouse tor a while. Then go select the Line or Pen 
tool and draw couple of lines, try selecting 
different colors on the control panel. Also you can 
try the Fill, Circle and Rectangle tools. 

Now Go to the animation menu, and Turn oft 
recording. Then select Play back option. All your 
move now will be played back. 

Later on, if you turn on recording any move you 
make will be appended to your animation file. 



Unless you select St.art New Animation, in that case 
you Will st.art a new animation file. 

Try to select other functions, and see the 
possibilities. Try the Text tool, the color cycling 
tool, try designing your own shapes using the built 
in shape editor program. The possibilities are 
endless. 

Hints: If your animation file changes the Scan 
lines, then it is a very good idea to initialize the 
Scan lines to an initial value by setting Y 1 =0, 
Y2 = 199 and Mode= 32 O and Palette=O, then click on 
the Scan command. This way you Vvill make sure 
every time your animation me is executed, the 
screen is reset to its original values. 
Also make s.ure your reset screen color and pen 
colors and pattern mode (Fill pattern, or Fill solid 
color). You can do this by selecting and initializing 
these options white record is on. 

Using The Control Panel: 

Here is a picture of the control panel with its 
functions: 
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The following is an explanation of each function on 
the control panel (The function is identified by the 
number): 

1- This control 'SH'' allows you to view all the 
shapes or fonts in the current selected shape 
table. The current selected shape table is 
indicated by control '3 which is the 'ST' 
command. 

2- 'M' Determines the drawing mode for the 
selected shape. 

3- 'ST' allows you to select a shape or font table 
to use with the animation tool (tool' 8) in the 
toot menu. This function allows you to paint 
with any shape on the screen. There are 6 
default shape tables: 
'1: is the shape loaded using the 'Load 
Shape· option. 
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•2: is the last shape used with the copy 
function. Which is the same one displayed 
by the Paste option. 
• 3: is font• 1 (standard 320 fonts) 
'4: is font "2 (standard 640 fonts) 
•5: is font • 3 (large colored fonts, only 
upper case) 
•6: is font •4 (large fonts, complete ASCII 
set) 

4 is the font number. There are 4 built in fonts 
as explained in the earlier function. 

5 the 'L' control allo'v'v'S you to change the 
luminosity of a : 
1-current color. 
2- current palette. 
3- all the palettes (the whole screen) 
depending on the setting in the Color option 
(This Color, This Palette, and AU Palettes) 

6 R, G, and Bare also affected by the setting in 
the ·color menu·. 
Any time you click on any color, the RGB 
value of that color is displayed in these 
windo'v'v'S. If you use the arrows, you can 
change the color to any of 4096 
combinations. 

7,3 same as 6 
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Scan Command attows you to change the 
resolution and the palette assignment of any 
line (0-199). By selecting a set of lines and 
manipulating them using 10, 11, 12, and 13. 

10 Y 1 indicate the first line the ·scan· wi11 affect. 

11 Y2 is the last line the ·scan· will affect. 

12 ·p· is the desired palette for the Y 1-Y2 lines. 

13 'Mode' is the mode desired tor (y 1-y2) 
either 320 or 640. 

These change won't be effective until you click on 
the ·scan· control. 

14 Palette Selection allows you to change the 
current displayed palette. With this option 
you can see all palettes. The L,R,G, and B 
option work on the current palette. 

15 Color Cycling: Tt.is option attows you to 
have color cycling effects. The idea is that 
you need to select two colors between them 
the color will be cycled. To select what set of 
colors to cycle, two steps are required: 
1- First Click on the last color to cycle for 
one second or so. (long click) 
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2 - Second Click on the first Color to cycle for 
one second or so. 
Now as you use the arrow, the colors Will be 
cycled between the two points you selected. 

16 Scroll bar: You can scroll the picture up 
and down. Before you use 'Hide Control 
Panel' in the ·option· Menu make sure the 
picture is scrolled all the way to the top. 
Else, the palettes for your picture might not 
looked right. 

17 Current Color: In this small window, the 
current selected color is displayed. 

18 Information Bar: When 'Show coordinate· 
is enabled, this window displays the X,Y 
coordinates of the mouse . The size of the 
animation file is also displayed on the right 
anytime you turn on/off recording. 

19 Color Selection: All 16 colors of the 
current palette are displayed here. The 
current resolution of these colors is 
determined by the 'Set GR Mode' in the 
'Option· Menu. When switching between 32 o 
and 640 mode, you will sometimes see some 
colors that are not good. If you switch to 640 
mode and the palette colors are designed for 
640 mode, you will not see strange colors. 

68 



CHAPTER 4 

Using ColorMtx program: From the Color menu, 
select Mix Colors and the screen vn.11 show three 
basic light circles and individual color control slides 
as shown below 

• file Edit O tlons 

Current 
Color 

This educational program is easy to use. There are 
many controls that makes mixing colors and 
designing custom palettes an easy task: 
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1-The left arrows next to the color selection allows 
you to select any of the 16 different palette to 
work with. This way you can select the palette 
that need to be changed. 

2- See each color its basic composition: click on the 
color and Vt?//L, the three basic component of 
that color are displayed. Using this option, you 
can get the feeling of the composition of each 
color. For example, if you select maximum red 
and maximum green, the resulting combination 
is yellow. Now you can change slightly the red 
and/or the green and see what color results. For 
example maximum red and half green is an 
orange color. Experiment a tittle, and you will 
soon have a sense of any color. 

3- Now, after you have selected a particular color, 
you can fine tune the RGB component of that 
color using the three color slide on the lower 
half of the screen. If you are creating a sunset 
scene, for example, you will need this option to 
find the best colors for transition from dark 
blue to light blue to yellow, orange then to red. 
The ColorMix program gives you even more 
control of two value of the color than the main 
menu of color+ does because colorMix gives you 
a feeling of what each color is composed of. 
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4- After you are satisfied that the color displayed 
is the one you like, go to that color. Click the 
mouse, and drag that color to the desired 
position in the currently displayed palette. 

In designing your own palettes, there are some 
special options to make this job easy for you. These 
options can be accessed from the Edit menu: 

1 
2 
3 

Edit 
This Palette ---> Buff er 
This Palette <--- Buff er 
Undo This Palette 

1- Using the 'Undo This Palette' option: At any time 
you can undo any palette to its original colors. The 
original colors of that palette are the ones on that 
palette when you first enet:red the ColorMix 
routine. 

2- Using the 'This Palette ---> Buffer' option: At 
any time you can save a palette to a buffer palette. 
This a convenient command when trying to copy 
one palette onto another palette or when you have 
a scene of many palettes and you want to slightly 
change the colors in consecutive palettes. You can 
copy one palette to buff er then copy the buff er to 
the palettes tliat you will be working with. After 
you have copied to and from the buffer, go to each 
palette and fine tune its colors. 
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Toggling between 32 O and 640 
One more useful function is toggling the displayed 

. palette between 320 and 640 mode. This is 
useful when working with 640 mode, and 
when working with 16 dithered colors on 
640 mode. Try it and see how it works. 

Quit to Color+ 
When you quit to Color+, any change you made for 
the palettes will show and be effective on the 
current picture. 

Pattern Editor Program. 

The pattern editor program is easy to use. It allows 
you to change patterns for the fill command. The 
current selected pattern will be displayed for 
editing. While you are in the pattern editor you can 
select any other pattern for editing purpose. Also 
an additional control is provided to see your 
palette in 640 mode. 

You can enter the pattern editor program from the 
Color menu of the main program. 
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Zooming 

The zoom option can be accessed from the tool 
menu. The resolution assumed when the zoom is 
executed is the resolution set by the SET GR 
MODE command in the option menu. Regardless of 
the actual screen resolution, the zoom routine will 
either be 320 or 640 mode. If you zoomed into 640 
screen resolution with current GrMode set to 320 
then you will not be able to control every pixel. To 
do so, you have to quit then change the GRMODE to 
640. Now, when you zoom again into that area, you 
witl have complete control. 

Shape !dltor program: 

There is a built in shape editor program inside 
Color+: Any time you copy a portion of the screen 
using the copy tool, it is saved as a shape table of 
2 shapes. One shape is the area copied. The second 
shape is empty. In many instances, you would like 
to make a series of shapes to be used with your 
animation file. For instancy, the bicycle parts, and 
the space craft and the bees. These shapes are 
drawn using the Shape Editor Program. 

You probably noticed that there are many shapes 
that are used with the animation toots. The shape 
editor program allows you to create shape tables 
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'I-Tith up 255 shapes on each table. You can even 
create and edit fonts for use with color+ using the 
shape editor. 

To Execute the Shape Editor program, go to the File 
Menu and Select 'Shape Editor· The first thing the 
program asked you is how many shapes you want 
in your shape table. This number of shapes you 
will be able to fit is the • you select minus one. If 
you want a shape table of up to 1 O shapes in size, 
enter 11. 

In the shape editor program you can do the 
following: 

• Edit shapes & Fonts 
• Load any shape or Font Table, Edit it and save it. 
• Select any of the l 6 different palettes to work 
with. 
• At any time see all the shapes present in the 
shape table. 
• Rotate and manipulate any shape you mnt. 
• Combine shapes from different shape tables. This 
is a useful option if you are going to combine 
shapes created with color+ and put them all into 
one shape picture. 

The File menu allows you LOAD and SA VE different 
shape or font tables. Note that a font table is 
technically the same as a shape table except that 
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fonts are pre-arranged in the order of the 
character set (i.e, they are alphabetized). To load a 
Shape table set Load Shape, and the shape load 
screen will allows you to see shapes in different 
folders and load them. Try to open the shapes 
folder and load any shape table FLY 3,SHP. Once 
you have loaded a shape table, you can see all the 
shapes within the table by using the arrow on the 
left of the screen. Later on, try to open the font 
folder and open the font table called: ALPHA3. 
This is the font table for the large colored font. Feel 
free to edit, modify or add fonts as you like. 

The SA VE option acts the same as the load option. 
You can save your work when you're done 
composing your shape or font table. Similarly you 
can save your shape table in any directory. You 
don't need to add the SHP suffix. The save routine 
will do that for you. 

To mix shapes from different shape tables, make 
sure the shape that you want to add to the other 
shape table is displayed in the large window. 

In the edit menu, you will have more control over 
your shapes: Clear Screen, Rotate ()OQ, Mirror 
Image, Upside Down, Toggle Grid, See Shape. 

Note: If you have a shape table that can fit 40 
shapes and this shape table contains 2 5 shapes, the 
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next shape you edit will alvvays be the last shape 
in this case, the next shape you make is shape 
number 26. Except when you select edit shape 
from the Shape menu, the next shape you make is 
the shape number that you have selected, when 
you are done the next time you make a shape the 
program will automatically remember the total 
number of shapes present in this shape table. For 
example, if you want to modify shape number 10, 
to do that, go to the shape menu and select edit 
shape, then enter 10. Now, the next time you use 
MAKE EVEN SHAPE, shape number 10 wm be 
made. After you have used that command the 
shape f)ointer Will again jump to the last shape in 
this example shape number 26. 

You can also Zoom in and out of a shape. To see the 
effect you zoom, select show grid or select see 
shape, and you Will see that your shape is bigger or 
smaller. 
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CHAPTER 5 

Graphics on the Apple I IGS: 

The video screen area is locate in Bank $E 1 starting 
from address $2000 and of length 32K. 

Each line on the screen can be assigned any of the 
16 available palettes, and either graphics modes: 
320 or 640. 

The following pictures clarify how pixels are 
arranged on either mode. 

In 320 mode: 
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Pixel 
Line O 
Line 1 
Line 2 

I 
I 
I 

0 2 3 ...... -319 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

~ Eech Pixel cen heve 16 possible 
V81ues (from o to 15) 
This number determines the color 
number In the p81ette. 
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In 640 mode: 

Ptxel o 
Ltne O 7 6 
Line t 
Line 2 

' I 

5 4 
2 3 4 5 6 7 ...... 639 

3 2 1 0 7 6 5 4 3 2 1 0 

Each palette contain 32 bytes of information for a 
total of 16 colors. Each color can have any or 4096 
value depending on the RGB components. Each of 
t::ie Red, Green, and Blue component have 4 bits of 
information (4 x 4 x 4 • 40()6). 
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The format of a palette is show in this picture: 

11 6 s 413 2 1 011 6 s 413 2 1 ol 
[Zero] Red Green Blue 

Using Color+ Pictures from Other Programs. 

1- You can load Color+ pictures from any paint 
program. But you will probably only be able to 
display 16 colors. Unlike color+, which supports 
2 56 colors, most programs support only 16. 

2- If you are writing your own program from any 
language, it is fairly easy to include 256 color 
pictures within you program. Here is one way you 
can do it: 

a- Since Color+ picture is saved in the standard 
way the Apple I IGS display graphics, all you need 
to do is load the picture in a particular memory 
location (you need to reserve in advance 32K of 
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memory). After you load a binary picture file, all 
you need to do to display it is move it to the Video 
screen location: $E 1 /2000 ($01 /2000 if shadowing 
is enabled, shadowing allows the picture data to be 
written on bank $0 1 of memory and shadowed to 
bank $E 1 which is the video ram): 

$9FFF 

$2000 

Sixteen 32-Bytes Polette 
1-------1 56 unused bytes 

i-------1 
200 scan bytes 

The Super Hi-Res Screen 
t 60 bytes horizontally x 
200 lines vertically 
(32000 bytes) 

.__ ___ __, 8192 decimol 

Bank $E 1 or Bonk $01 If shaddow1ng 
1s enebled. 
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$0E/2000 

or $01/2000 if shadowing is enabled. 

The picture format is as following: 

Each picture has 2 00 lines. Each line has 160 bytes 
of pixel data. Therefore, each picture has total of 
160 X 2 00= 32 000 bytes. 

In addition each line has 1 SCB byte associated 
Vvith it. 

Also, each line can be assigned 1 of the 16 
available palettes. 

The total length of a standard picture is 

32000+256+512= 32766 bytes. 
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Appendix A 

Trouble Shooting: 

1- If you hear a beep. then your program 
has crashed. All you need to do to make it work 
again is: 

Press: 
CTRL-C, then followed by 'RETURN' Twice. 
then, TYPE: 

RUN TOMAIN.INIT 

In most cases this works. Your program will be on 
track again. At this point It is recommended that 
you save your work. However if it did not work 
type this command: 

RUN INIT.2 

H Mouse is not reaching all the screen or If 
you feel that the mouse cursor is behaving 
strangely here is how to recover: 

Keep pressing CTRL-C (hold down the control key 
while pressing on 'C') untlt you hear a beep. After 
that press 'RETURN' key a couple of times. Then 
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type: TOMAIN.INIT this file 'Nill display your latest 
picture and put you inside Color+ program. At this 
point, save your work. 

To start with new picture type: INIT.2. 

If this still did not work, you need to r~boot your 
disk. 

In any case please report all bugs to us, so we can 
try to fix them. 
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APPENDIX B 
Going Beyond 2 56 Colors 

If 2 56 colors at once is not enough for you, there 
are some techniques to increase this number to 
more than 256 colors at once. One way to do it is to 
use interrupts (a signal that force the 
microprocessor to jump to a subroutine) the 
interrupt subroutine can change the colors in a 
particular palette. With this techniques the 
maximum number of colors that can be displayed 
at once is 32 00 colors by assigning to each line 
different palette. On the IIGS there are 200 tines 
each line can be assigned one palette ( 16 colors) a 
total of 200 x 16 • 3200 colors. One drawback of 
these kind of pictures is that you cannot do much 
with them because the microprocessor is 
overloaded by servicing the interrupt routines 
(because interrupt routines should occur fast 
enough to get the illusion of more than 256 colors). 
These kind of pictures are only good for display 
mode. In a later release Color+ might have the 
ability to do so. The other technique of displaying 
more than 2 56 colors at once is when using 
animation. As an object is being animated, the user 
can change the working palette and this will give 
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the illusion of more than 2 56 colors. This kind is 
better when using animation. 
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